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Overview

Part1: Introduction to data loading and 3D
visualization of brain images

Part 2: 3D interactive exploration of the
segments of the liver

Part 3: 3D interactive exploration of the
segments of the lung
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3D Visualization of the Anatomy

®

Following this tutorial,
you will be able to load
and visualize volumes
within Slicer4, and to
interact in 3D with
structural images and
models of the anatomy.
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®

3DSlicer

Powerful processing. Streamlined interface. 1 Extensible platform.

Slicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3DSlicer is a multi-institutional effort
supported by the National Institute of
Health.
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3DSlicer

®

* An end-user application for
image analysis

* An open-source environment
for software development

» A software platform that is both
easy to use for clinical
researchers and easy to extend
for programmers
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www.slicer.org

®

®eno - - - - 3D Slicer

[« [ > ] [+ [Entp:/ jwwwsicer.org/ ¢ Ji(Q- Google )
L Slicer
b li A multi-platform, free and open source software package for
{ 3DS icer visualization and medical image computing
. 4
u . Download  Tutorials Reference  Feedback
d mMuiti-platiorm
uuuuuuuuuu
L Powerful processing. eal Extensible platform.
AAAAA Slicer !
solftware runningon - ==
nnnnnnnnnnnnnnnn
aaaaaaaaa

Windows, Linux,
and Mac OSX.

Disclaimer

It is the responsibility of the user of 3DSlicer to comply with both the terms of the license
and with the applicable laws, regulations and rules. Slicer is a tool for research, and is
not FDA approved.
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‘ﬁb 3DSlicer History

Image Courtesy of the CSAIL, MIT

1997: Slicer started as a
research project between the
Surgical Planning Lab (Harvard)

and the CSAIL (MIT)
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®

3DSlicer History

Extensible platform.

Y.
\ VO »
¢ " -~ .

1997 Slicer started as a
research project between the
Surgical Planning Lab (Harvard)
and the CSAIL (MIT)

2011: Multi-institution effort to
share the latest advances in
Image analysis with clinicians
and scientists
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NA-MIC and NAC

NA-MIC Wiki

General
»Overview
»Organization
»Contact Us

Center Components
»Algorihms

»Engineering

»Drving Biological Projects
»Colaboration Grants

Resources
»Publication DB
»image Gallery
»Downloads
»Service
»Training
»Dissemination
»Events.
»Links

National Alliance for Medical Image Computing
A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

(GOt Custom Search] ST

Neuroimage Analysis Center

"understanding the human brain through imaging”

RSNA "3”01’1‘V

0 Read more.

1 0f 23 Photos

The Natlonal Alllance for Medlcal Image Computing (NA-MIC) is a

y team of p scientists, software
engineers, and medical ir { who develop { tools for
the analysis and visualization of medical image data. The purpose of the
Center is to provide the infrastructure and environment for the
development of computational algorithms and open-source technologies,
and then oversee the training and dissemination of these tools to the
medical research community.

Supported by the National Institutes of Health, Roadmap Initiative.

Information about collaborating with NA-MIC is available on our wiki.

97th Scientific
Assembly and
Annual Meeting

November 27 - December
2, McCormick Place,

0 NEWS ARCHIVE

About the NAC
»Overview
»Organization
»Research Cores
»Collaborations

Resources
»Contact Us
»Publication DB
»Image Gallery
»Downloads
»Training Materials
»Web Archive

dev.) are displayed on an inflated
lateral-posterior). mmmhmvmmdhmwm«smmmmum

)¢ W’&@ )

DDC Group

State-space Models of Mental Processes from fMRI
Spatial Maps. The sverage cors mape of e o groups (vaxskwise group sverage divded by group sid.
brain-surface (left left mediak-posterior,

, right medial-posterior and right

The Neuroimage Analysis Center (NAC) develops image processing and analysis techniques for
basic and chnlcal neurosciences. The NAC research approach emphasizes both specific core
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1 projects. The activities of the NAC are centered at the

Harvard Medlcal School and the Surgical Planning Laboratory at the Brigham and Women's
Hospital in Boston, with collaborators throughout the United States and the rest of the world.

The NAC is a major research center supported by the National Center for Research Resources
(NCRR), a component of the National Institutes of Health.

P YYYH

P.l. Ron Kikinis, M.D.
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Slicer: Behind the scenes

§ Safari File Edit View History Bookmarks Window Help GO M S <) @ 11:07AM Q
CDash - Sicer4
+ |€ http:/ /www.cdash.org/slicer4 /index.php?project=Slicer4 ¢ Q- Google

Login All Dashboards Doo N o208 00

Slicer4

S . . u .
Dashboard Calendar Previous Current Project I I C e r I S b I I t e V e
'WARNING: This CDash instance is running the bleeding edge svn trunk CDash code, and is updated frequently. You | ry

1 file changed by 1 author as of Sunday, November 27 2011 - 22:00 EST

nlght on WindOWS,

Windows7-VS2010-32bits-QT4.7.1-PythonQt-With-Tcl-CLI-

factory-win7 Kitware Roloase @ 107 .
factory-mac-64bits.kitware SnowLeo?erqg++4.2. 1-64bits-QT4.7-PythonQt-With-Tcl-CLI-
Release W&
factory-ubuntu-64bits.kitware LS:*Q»M.4.3«54bns—QTA47-Py!nonQt—wilh-Tcl—CLl-Relaase
factory-win7.Kitware VWHWWSZ-VS\ZOOG-S“DWS—QTL[‘I -PythonQt-With-Tcl-CLI-
Release &/
factory-win7.kitware Wmdows?-VSZOOB-GZMB—QT‘QJJ -PythonQt-With-Tcl-CLI-
Release %

site Build Name Build Time
whitecube kitware & SnowLeopard-gocd.2.1-Qt4.7.0-PythonQt-With-Tel-Release 11 hows ago
@
. OpenSuse-c++4.5.0-64bits-QT4.6.3-PythonQt-With-Te-NoCLI- T
Release
eris itware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release 3 hours ago
e Iinx(«y-m.4,3-QT4.7-Pymoan-W’nh-Tcl-CLI-Valgvind—Relsase .,
factory-ubuntu-64bits Kware Linux-g++4.4.3-64bits-QT4.7-PythonQt-With-Tcl-NoGLI- 11 hours ago

Coverage-Release
sagarmatha.kitware Linux-g++4.3.3-QT4.7-PythonQt-With-Tcl-NoCLI-Release 12 hours ago

Build Time

OpenSuse-c++4.5.0-64bits-QT4.6.3-PythonQt:

1 hour ago
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N Slicer Training

* Hands-on training
workshops at national
and international
venues

« >1,700 clinicians,
clinical researchers
and scientists trained
since 2005
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3DSlicer version 4.0

800 3D Slicer 4.0.gamma-2011-11-14

& Modules: . Welcome to Slicer = 00 MO @ 4 @HE 2 |EHI e t-Persistent fn o, -
1

®

@ sosticer
Welcome
ﬁ, Load DICOM Data ,ﬁy LB

@ Load Volume Data || @ Downloz

[» About

[» The Main Window
[» Loading and Saving
|» Display

[» Mouse & Keyboard

[ » Tutorials & Information

[» Acknowledgment

|~ Data Probe

L
F
B

None RAS: (125.0, -125.0, 1.0),
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Welcome to Slicerd

ano

3D Slicer 4.0.gamma- -11-
& & |Modules: . [Welcome to Siicer - DO asPH & t -0 Persistent w R
ow [
[B zosiicer
-4

N /
Welcome

Gis; Load DICOM Data oy Load Data
@ Load Volume Data || @ Download Sample Data
» About
» The Main Window
» Loading and Saving
» Display
» Mouse & Keyboard
» Tutorials & Information

/
» Acknowledgment

To start Slicer, select Start > All
Programs->

Slicer4-4.0.gamma-2011-11-23
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Welcome to Slicerd

ano

ma-2011-11-14
2 & |Modules: - |Welcome to Slicer s DO e sA@PHE 2 @ | t - Persistent o fa

, . /
Welcome

Gis; Load DICOM Data oy Load Data
@ Load Volume Data || @ Download Sample Data
» About
» The Main Window
» Loading and Saving
» Display

» Mouse & Keyboard

» Tutorials & Information

/
» Acknowledgment

Click on Welcome to Slicer to

display the 92 modules of Slicer in
the Modules menu
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ACPC Transform
Add Images.
2 Annotations
BSpline to deformation field
Cameras

Cast Image
ChangeTracker
CheckerBoard Filter
Colors

Create a DICOM Series
Crop Volume

DICOM

‘ommand-iine
i EMSegmenter with Atlas

& EMSegmenter without Atlas
Editor

Endoscopy

Event Broker

Execution Modei Tour

Expert Automated Registration

Extract Skeleton
Fast Affine registration

Fast Nonrigid BSpline registration

ion

ng (BRAINS)

Curvature Anisotropic Diffusion

DWI to Full Brain Tractography

General Registration (BRAINS)

Gradient Anisotropic Diffusion

Grayscale Fill Hole

Grayscale Grinid Peak ]

Grayscale Model Maker ~ Scene Views

Histogram Matching Simple 0 Test

Image Label Combine Simple region growing

Intensity Difference Change Detection (FAST)

Joint Rician LMMSE Image Filter

Label Map Smoothing

Label Statistics o

Linear registration

MR Bias Field Correction T hy Fiduc

Mask Image Tractography Labelmap See

WMasictrom Diffsio Weighied images Transform MRML Files o N

Transforms

Unbiased Non
View Controllers

© Volume Rendering

@ Volumes t
Voting Binary Hole Filling b v
Welcome 1o Slicer

EMSegmenter Standard i

Al Means filter for DWI

ime With Model (Paint) e
Resampl
Resample Scalar Volume
Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Slicer4 contains more
than 90 modules for
Image segmentation,
registration and 3D
visualization of
medical imaging data

©2011 Surgical Planning Laboratory, ARR
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SPL

PART 1: LOADING A DICOM
VOLUME




‘ﬁ' The DICOM 3.0 File Format

Most radiological imaging equipment produce images
in DICOM file format (‘.dcm files’)
|

— — Image001.dcm

Header

Image002.dcm

Raw Data

Image003.dcm
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Slicer4

Persistent fa Fa v

aNno 3D Slicer 4.0.gamma-2011-11-14
2 #& [Modules Welcome to Slicer DR N0 e A9E 2
o= [l

[B) osiices

Welcome

[say Load DICOM Data
@ Load Volume Data || @ Download Sample Data

oy Load Data

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Tutorials & Information

» Acknowledgment

\

N

Select File-> Add
Volume in the

-~ main menu

~ Data Probe

L
F
B

None RAS: (125.0, -125.0, 1.0),

©2011 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

& Slicer %O MM T 4) & 134AM Q
000 3D Slicer 4.0.gamma-2011-11-24

» ‘3 £ v Persisent | @ Sw R | 4

@ % |Modules: -, [Welcome to Siicer =00 IO @ & 9 <
1

@ 3DSlicer
Welcome

Load DICOM Data || [y Load Data e o
Load Volume Data \ ) Download Sample Data Lookin: (i Msers/spujol/RSNA2011 000 RE E]
/i'\ spujol Name Size | Kind
[ About
(2 liver-data ~ Folder

\ » The Main Window (] lung-data - Folder

(£ 3Ddate-head - Folder

[» Loading and Saving

\ » Display

[ Mouse & Keyboard

[ » Documentation & Tutorials

[ » Acknowledgment

< | ID

Files of type: ‘ All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *.mgz *.img *.pic *.d $ H x c !
ancel

Browse to the location of the dicom directory, located in
C:\Documents and Settings\Administrator\Desktop\3D

File name:

| v Data Probe

-
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Loading a DICOM volume

& Slicer GO M T 4) G 134AM Q
000 3D Slicer 4.0.gamma-2011-11-24

|R & [Howes - Wommenser  51m O O @ @ A G @ - [0t B A |+
1]

a®
@ 3DSlicer

Welcome

(s Load DICOM Data | (a5, Load Data J
[ Load Volume Data | [_g Download Sample Data ]

[» About

Lookin: | ga/Users/spujol/RSNA2011_DATA/3D/dicom 000 #EEBE
4 spuc  Name v [Size Kind
(3 1.3.12.2.1107....34611700000004 -- Folder

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

il D) [ [»)

File name: | || & Qpen

Files of type:|All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *.mgz *.img *.pic *.( ¢ | X Cancel
Centered | Ignore Orientation | | LabelMap

« Single File

GI

» Acknowledgment

Options:

Slide 20
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Loading a DICOM volume

& Slicer L RON ) G 134AM Q
000 30 Slicer 4.0.gamma-2011-11-24 |
G & |Modules: - [Welcome to Sicer " 00N O @ &A@ a » | ¢ viiPessent | @ Am Fo | 4 v
o® —
Q 3pSlicer
Welcome Open
£a/Users/spujol/RSNA2011_...17401884850201701.0.00+ | © © @, @\@\
[t Load DICOM Data || [y Load Data

v/

Load Volume Data

[ » About

[ » The Main Window

| > Loading and Saving

:32.35162.3.200611171750039867702111
.32.35162.3.200611171750061380702172
2.35162.3.200611171750095828102238
.35162.3.200611171750149192502346
2.35162.3.200611171750152533202364
.32.35162.3.200611171750222774702520
.32.35162.3.200611171750266856202604
.32.35162.3.200611171750284197102646 -

| >

\ » Display

[ Mouse & Keyboard

[ » Documentation & Tutorials

[ » Acknowledgment

- SEENNNEEEEEED

K [T»
File name: 1.3.12.2.1107.5.2.32.35162.3.20061117175018396 102430 & Open
Files of type: | All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *.mgz *.img *.pic *.c ¢ X Cancel‘

Select th e .I:I rs t f||e |n the Centered | Ignore Orientation | | LabelMap
list of DICOM images and
click on Open _

[
©zu11 Surgical Flanning Laboratory, ARR
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Loading a DICOM volume

800 3D Slicer 4.0.gamma-2011-11-24

& & |Modules: -, [Welcome to Slicer dm Q00N &« A 9@ »E ‘;‘ $~ 2@ e | v

Welcome
| @&w Load DICOM Data [ [as Load Data |
| @ load VolumeData || (@ Download Sample Data |

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

Slicer displays the axial, |
coronal and sagittal slices
of the DICOM dataset
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Loading a DICOM volume

800 3D Slicer 4.0.gamma-2011-11-24

& & |Modules: -, [Welcome to Slicer dm Q00N &« A 9@ »E ‘;‘ $~ 2@ e | v

ex H1
@ 3DSlicer
Welcome

| @&w Load DICOM Data [ [as Load Data |
| s Load Volume Data | @ Download Sample Data |
» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

Left-click on the
Slicer layout icon
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Loading a DICOM volume

800 3D Slicer 4.0.gamma-2011-11-24
@ % |Modules: -, [Welcome to Sicer s = QOO @« 294 - El|e] t ~ipessen | @ e Fa, -

(2]E3) Conventional
Conventional Widescreen

Q 3DSlicer

Welcome

[ Yellow slice only
[E Green slice only

Load DICOM Data Load Data
Load Volume Data ) Download Sample Data [ Tabbed slice
B Compare ,
» About [M Compare Widescreen ~ »
B Compare Grid >
» The Main Window H Three over three

B Four over four

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

R S:885 |- Y

Select Red slice only from the
layout menu
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Loading a DICOM volume

8006 3D Slicer 4.0.gamma-2011-11-]
& |Modules Welcome to Slicer il DO e A@§L » E & | § v Persistent Ra Fo,
D
& <x i | Axal D Q. -
@ cccccc ]v o =2 None E—
1§ | None
Wel e s~ @
[ty Load DICOM Data [y Load Data
T L a @ Download Sa ata
About
The Main W
i

» Acknowledgment

£ 4
w
/ /
g v
4
v >
§ - D
E S ]
-
v
- ’

Position the mouse button at the top left éorner of
the window to display the slice menu
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Loading a DICOM volume

L YeXe 3D Slicer 4.0.gamma-2011-11-24
& & |Modules: -, [Welcome to Siicer 3] - DO @ &A@ Ol t v perssen fa 5o -
o e HE 1S:8.85
h &, x| Axal S .
£ Slicer o 1x1view
| > o = Nong
=4 = 4 Ix2view F
B [None 13 view
@ | & 11 1x4 view
Welcome CARNRERE T e
X8 vie
e

(S Load DICOM Data [y Load Data
[ﬁ Load Volume Data @ Download S4

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowl ledgment

Click on the Lightbox view icon
in the slice menu, and select the ™ |
6x6 view option
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Loadlng a DICOM volume

Y G

& [ Modul

2 ﬁ o g. Persiste

g2l |g

Gl.| [
g %’ EL?

(3 [~

o

$

o

2

2

14

3

3

3

o

g

5

Slicer display 36 consecutives
images of the dicom volume.
Use the red slice slider to

browse through the dicom data Side 27



Loading a DICOM volume

eno 3D Slicer 4.0.gamma-2011-11-24
@@ & IModules: - [Welcome to Siicer T) - DO e A@94d - | § v Persistent S S -

{;\ Slicer

ﬁ Load DICOM Data lﬁ‘ Load Data
s Load Volume Data @ Download Sample Data
» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyl

» Documentation & T

» Acknowledgm: -

-

Left click on the red ilndo
icon, and select the
Conventional layout
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Loading a DICOM volume

[ Ye)

3D Slicer 4.0.gamma-2011-
& |Modules: Welcome to Siicer =0 4vmo%{{\wa>>gtvPevss:er',k(uihv
=

Welcome I Select the lightbox viewer in the

(Gissi; Load DICOM Data [y Load Data

R ——— red slice menu, and come back
to 1x1 view
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Loading a DICOM volume

eno 3D Slicer 4.0.gamma-2011-11-24
& |Modules: - [Welcome to Siicer " 00 IN® @« A @ HE » | § v Persistent fa R,
e ~
m 3DSlicer
L4

—o .22z Click on the links icon to link all
three viewers, and on the eye
icon to display the slices in the
3D Viewer

v Data Probe
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‘ﬁb Loading a DICOM volume

ma-2011-11-24

Awi & |Modules: - [Weicome to Siicer "m0 0 IO e 49 HE . (o] Q' Persisient | g Mm Ra ¢
=]
@® .

Welcome

The three .
anatomical slices

appear in the
3DViewer
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Loadlng a DICOM volume

& |Modules Welcome to Slic s = DO e« A @ L » o gv Persistent B -
o® Ml

(:3 Slicer
— 4

Use the left-
mouse button to
rotate the

camera, and the
right-mouse

and out
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Close the scene

eno

3D Slicer 4.0.gamma-2011-11-24

@ & |Modules: - [Weicome to Siicer =00 IO &« 2 @H » & | § v Persitent o o v
EE]

BY soslicer

g

Welcome

I o 7

Load DICOM Data Load Data
lﬁ/ Load Volume Data © Download Sample Data

Select Fié Close Scene to

| > The Main Window

= close the Slicer Scene

['» Mouse & Keyboard

[» Documentation & Tutorials

[ Acknowledgment

‘ v Data Probe
Yellow RAS:(-6.4,25.8, 181.6) Sagittal Sp: 0.8
L None ()

F None ()
B11  (117,-70, 88) Out of Frame
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Exit Slicer

8no 3D Slicer 4.0.gamma-2011-11-14
@ & [Modules « Data "0 Q0 INO® @ 4 @PHE < | & v Persistent | @ M S -
1
B sosiicer
e

» Help & Acknowledgement

~ Display & Modify Scene
Nodes
=Scene
View1
Default Scene Cameral
Scene Model: | Transform &
Display MRML ID's
Show Hidden nodes

Filter:

Select Slicer->Quit to exit the
software

» Load & Add Scenes Or Individual Datasets

~ Data Probe

o W
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Part 2:

3D visualization of surface
models of the brain
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A Slicer scene is a MRML file which
contains a list of elements loaded
into Slicer (volumes, models,
fiducials...)

The tutorial scene contains an MR
scan of the brain and 3D surface
models of anatomical structures.
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‘ﬁb 3D models of the brain

» The tutorial data are part of the SPL-PNL
Brain Atlas developed by Thalos et al

« RSNA 2011 Presentation:

Publicly available RaxLex-linked Anatomy

Atlases for Image Analysis Informatics and
Education. Michael Halle, Samira Farough,
Marianna Jakab, Ron Kikinis

Thurs. Dec.1st, 11:10-11:20 am
Room S402AB

©2011 Surgical Planning Laboratory, ARR
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Loading a Scene

8no Slicer 4.0.gamma-2011-11-1.
& & [Modules: 4 Data " 00 IN® e A9 HE &t~ Persistent | [ fm S
ox HI

[B osice

~ Display & Modify Scene

» Help & Acknowledgement
Nodes

View1
Default Scene Cameratl

Scene Model: | Transform
Display MRML ID's
Show Hidden nodes

Filter:

Select File & Load Scene
from the main menu

» Load & Add Scenes Or Individual Datasets

Slide 38
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Loading a Scene

|R & Modes: [sDia /= QO DO & s ©@ < E|e - Pesisen

g 30Slicer

[» Help &

L
|~ Display & Modify Scene
Nodes
=Scene

View1

Default Scene Camerat Look in: EA i 1/3DVisualizati OO0 AREBEME

Scene Model:| A spuiol Namo sz [Kind A

Display MRML ID's
Show Hidden nodes

Filter: (

slicerd4minute.mrml

% Master Scene View.png
6T I

File name: |slicerdminute.mrm!

Files of type: [An (.mrml * xml * xcat)
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Loading a Scene

eno 3D Slicer 4.0.gamma-2011-11-14
& # [Modules: |4 Data " QO IN® e A9 HE 2 & & -~ Persistent | [ fo S -

Q soticer rYar) —
» Fielp & Acknowledgement Look in: £a/Users/spujol...A2011_DATA/3D ¢ | Q) © © @ (2] [E)
~ Display & Modify S . . .
T —— 4 spuic | Name v Size Kind
-S\(}ene1 ~
D‘glzuh Scene Camerat 2 |
Scene Model: | Transform [} d_ICOm -- Folder
Display MRML ID's {3 LiverData -- Folder
Show Hidden nodes [~} lUngData -- Folder
Filter:
R
4 » 4 »
File name: 4 Open
Files of type: | All (*.mrml *.xml *.xcat) S XCanceI

Select the directory 3DHeadData, and open the file
slicerdminute.mrml

L
F
B
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Loading a Scene

8no 3D Slicer 4.0.gamma-2011-11-14
& # Modules: 4 Data " 00 IN® e A9 HE &) t v Persistent | @ Aw Fa, -

B wosiicer

» Help & Acknowledgement

.N.O Open

~ Display & Modify Scene

fodos Look in: a/Users/spuijol...3D/3DHeadData '+ | Q © @ @ (1) [E)
= Scene i
Defauit Scene Camerat | 7 spuic  Name v Size Kind

-
|

Scene Model: | Transform :
Display MRML ID's
Show Hidden nodes

-
B N

1
)

I
|

Filter:

B ]

R slicer4minute.mrm ...B__mrml File 000
4 » 4 »
File name: |slicer4minute.mrml 4 Open
Files of type: | All (*.mrml *.xml *.xcat) + || X Cancel

Open the file slicerdminute.mrml

» Load & Add Scenes Or Individual Datasets

~ Data Probe

onr
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Loadlng the Slicer Scene

eno cer 4.0,
@ & |Modules: . [Welcome to Slice I-JO{DO%AUZ

A 3D surface model of the
head, and 2D anatomical
slices appear in the Viewer.

| » Display

| » Mouse & Keyboard

| » Documentation & Tutorials
| » Acknowledgment

l\]t > @ e G| 4~

| ~ Data Probe

mnr
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Loading the Slicer Scene

8
@ & |Modules: . [Welcome to Slicer

@ 3DSlicer
Welcome

| &= Load DICOM Data || (s Load Data J
| mi@ Load Data || @ D ple Data |

SDsSlicendOoamua 2RI
=00 @& s @@ ~EHe t-

ex [l

[» About

[ » The Main Window

[» Loading and Saving

| » Display

| » Mouse & Keyboard

[ » Documentation & Tutorials

[ » Acknowledgment

[~ Data Probe

L
F
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Models module

800 3D Slicer 4.0.gamma-2011-11-24
@ & [Modues: (@ Models Hm QRO IO e« 4~ 9@ E| § v iPesisent | @ Am S| 4 v
1

@®
@ 3DSlicer

» Help & Acknowledgement

=-Scene

# hemispheric_white_matter.vtk 1.
# left_eyeball vik m
# optic_chiasm.vik 1.
# optic_nerve_L.vtk 1.
# optic_nerve_R.vtk 1.
# optic_tract_ L.tk 1

1.

The list of 3D
= models appear in

» Information ‘

= - the Models panel

88888888

Selected:

Clip:

Slice Intersections Visible: -
v Material Properties

Color: ( O

Opacity: 0[100]7]
Ambient: @ (0004
Difuse: 0[100]Z]
Specular: (7 [EE
Power: @ (o

Backface Culling: ¥,
Preview: ﬁ Presets: y :m
L

» Scalars

» Clipping J

v Data Probe J

Yellow RAS: (0.0, 166.7, -67.1) Sagittal Sp: 1.0

| Neana
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®

3D Visualization

B b s fores = QO DO @A GE -H0] L e @ | e

ox i
@ 3DSlicer

» Help & Acknowledgement

=-Scene
# hemispheric_white_matter.vtk
= left_eyeball.vtk
# optic_chiasm.vtk
# optic_nerve_L.vtk
rve ALVt
L.vt

v Data Probe

Yellow RAS: (0.0, 166.7,-57.1) Sagittal Sp: 1.0

| Neana
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3D Visualization

|2 & |Modules: . [@Models = Q. O I0 @ & @ ”El@ t- > B R R | 4~

g 3DSlicer

» Help & Acknowledgement

= Scene

= hemispheric_white_matter.vtk
= left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk

= optic_nerve_R.
= optic_tract_L.vtk
= optic_tra vtk

= right_eyeball.vtk
= skull_bone.vii K

85385358

» Information

~ Display

Visible: v

Selected:

Clip:

Slice Intersections Visible:
v Material Properties
Color: ( [m] ]
Opacity: :.
Ambient: C 10.00 |2
Diffuse: j.
Specular: 0 (0.00 4]
Power: s (1.0 4

Backface Culling: v
~ Data Probe

wmr

©zU11 Surgical Flanning Laboratory, ARR Sliae 40



3D Visualization

& Slicer File Edit View Help

& & |Modues:

@ 3DSlicer

[ » Help & Acknowledgement )

Vodels = Q00N @ A @ [@] t -0ipessen

= Scene
# hemispheric_white_matter vtk
» left_eyeball.vik
# optic_chiasm.vik
» optic_nerve_L vtk
# optic_nerve_Rvik
# optic_tract_Lvtk
ic_tract Avik
bal

[ Information )

[ ~ Display ]
Visible: v
Selected:

Clip:
Slice Intersections Visible:
v Material Properties

Color: ( [m] )

Opacity: —_— (047

Ambient: @ (000 2]
J[100f2)

Diffuse:

Specular: &
Power: @

Backface Culling: [/
e Gl e
._

, Scalars

[ Ciipping ]

[+ Data Probe )

Yellow RAS: (0.0, 166.7, -57.1) Sagittal Sp: 1.0

L None ()
F None ()
B None ()
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3D Visualization

eoo 30 Sicer 40.gamma-2011-11-24
& & |Modules: . [@Models " QOO & A @ - B @ 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement I

®

= Scene
= hemispheric_white_matter.vtk
» left_eyeball.vtk ||
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk | |
= Skin.vtk
bone. [ ]

=555885558

Information

~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: (

~ Data Probe
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3D Visualization

® Slicer File Edit View Help
B g |Moes (O 3™ QOINO @ s @ »| B @ t v pessen | [ Ba Ro | 4 v
1

EE)
@ 3DSlicer

[ » Help & Acknowledgement

®

= Scene
# hemispheric_white_matter.vtk
# left_eyeballvik
# optic_chiasm.vik
» optic_nerve_L vtk
# optic_nerve Rvik

# optic_tract_Avik
# right_eyeballvtk
# Sxinvik

9

3
< ates

£
Oaadaada
8883838383

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
'y Material Properties

Color: ( [m]

Opacity: —_—
Ambient: @

)

Diffuse: a[100[Z)
38

(an Tal

Specular @

The 3D sur%ace of the‘
white matter appears in
the 3D viewer
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3D Visualization

®

_ @& Slicer File Edit View Help % D m « @ 0O Q
eno 3D Slicer 4.0.gamma-2011-11-24
@ & |Modues @ Models = QO IO @ A @@ | 4 v Persistent fe So
= B

B®
{D 3DSlicer
4

[ » Help & Acknowledgement

= Scene

# hemispheric_white_matter.vtk 1.00
# left_eyeball.vtk . 100
# optic_chiasm.vtk 1.00
# optic_nerve_Lvtk 1.00
# optic_nerve_R.vtk 1.00
# optic_tract_Lvtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball.vtk W 100
# Skinvik 0.00
g 1 1.00 |
[ > Information
[+ Display
Visible:
Selected
Clip:
Slice Intersections Visible:
v Material Properties
Color:
Opacity: _— 1]
Ambient ———————[000[%
Diffuse: _— 1]
Specular: 2 210.00 (=4

Click on the eye icon in
the green viewer to
display the coronal slice
in the 3D viewer
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3D Visualization

0no 3D Slicer 4.0.gamma-:
%2 & Modules: @ Models s -

®

| @ B fa

@ 3DSlicer

» Help & Acknowledgement

eric_\

= left_eyeball.vtk
» optic_chiasm.vtk
» optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

— | model
hemispheric_white matter.vik,
and select the option Clip in the

~ Display |
Visible: v

Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

Color: A

Opacity: —_—1.00 ] A\ DISpIay tab
Ambient: /000 %

Diffuse: —ee[1.00 |2

Specular: —/0.00 =

Power: — 10 *

Backface Culling: v 3

~ Data Probe

mTnr
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3D Visualization

800 3D Slicer 4.0.gamma-2011-11-24

_,0_‘JQO%AWE>»0tv > @ Ae Fa -

®

% & [Modules: @ Models

[ENRE

@ 3DSlicer

» Information

~ Display
Visible: v
Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

Color:

Opacity: —_—1.00
Ambient: F 0.00
Diffuse: —1|1.00
Specular: ——/0.00

elect the tab Clipping, and set
the Green Slice Clipping to
Negative Space

) 3 ) G [

Power: F 1.0
Backface Culling: v
Preview: g Presets: B

» Scalars
~ Clipping
Clipping Type: @ Union (@
Red Slice Clipping: *— Positive O &
Yellow Slice Clipping: © *  Positive © *
v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

wmr
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3D Visualization

®

[ JeXe) 3D Slicer 4.0.gamma-2011-11-24

% & |Modules: | @ Models "0 IO & AW 2 » ol 4~ > @ Ao R
1

@ o
®

@ 3DSlicer

The optic chiasm appears
in the 3P_lviewer

oy

Color:

Opacity: ———1[1.00 |J
Ambient: —=—ox0.00 |
Diffuse: —_— (1002
Specular: ——=0.00 *
Power: (10 [

Backface Culling: v

Preview: g Presets::_y m

» Scalars
~ Clipping |
Clipping Type: 9 Union @ (@, Intersection

Red Slice Clipping: *— Positive O +— Negative
Yellow Slice Clipping: © £ Positive © £ Negative

v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

T
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3D Visualization

e no 3D Slicer 4.0.gamma-2011-11-24

%2 & [Modules: - |@ Models = Q. 9 DO e« A g » B lle ¢t~ > @ Ao R -

Q 3DSlicer

» Information

~ Display
Visible: v
Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

D14 n&

Calar-

Select File 2 Exit tov close the Brain Scene, a Slicer

)

Power: (10 %
Backface Culling: v
Preview: &

» Scalars

~ Clipping
Clipping Type: 9 Union @ (@, Intersection

Red Slice Clipping: *— Positive O +— Negative
Yellow Slice Clipping: © £ Positive © £ Negative

v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

T
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Part 3:

Interactive 3D Visualization
of the segments of the liver
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Anatomy of the liver

Right Right Left Left
posterior anterior medial lateral
section section section section

Right hepatic vein

Umbilical vein
(remnant)

Hepatic duct
Inferior vena cava

Cystic

Hepatic artery
duct

Portal vein

Gall bladder Bile duct
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‘ﬁb Liver dataset

The liver dataset is

a contrast-enhanced CT
abdominal scan of a
healthy 36 year-old male.
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'ﬁ' 3D segments of the liver

''''''

~ __ SegmentlVa

Segment VI Segment Il

Segment VI - Segmentlil

Segment V ~ Segment [Vb .
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ﬁ' 3D segments of the liver

|
Segment | | Segment |

Segment Il
Segment Vb Ve | *=" Segment VI

Segment V
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Liver vasculature

Middle Left portal .
AEENE HEll vein = |eft hepatic

q T vein
Rig ht pOrtaI | : ' ) S - ~‘:- \.- .I‘.I_-‘_::‘-""'/:'.'; :,—i:’,{( \::ﬂf; - | "i
i SRR SR & Caudate vein | =

Vel gk iy o h “— ‘

——
—

o

e

Main portal

Right hepatic gt
vein
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Loading the Liver Scene

Slicer 4.0.gamma-2011-11-
™ QO IN O @ A @ HE 2 & | t v Persistent | [ fm S -
o [l

/
AN /
AN /

Select File 2 Load Scene from the main menu

eeeeeeeeeeeeeeeeeeeee

llllllllllllllllllll

Load the file Scene-Liver.mrml located in:

C:\Documents and Settings\Administrator\Desktop\3D\LiverData
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Liver Segments Scene

The elements of the scene appear in the Viewer
\@msucer S

Welcome
s, Load DICOM Data | o Load Data |
Gaw Load Data || @ D: Data |
» About

*» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

whr
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o) 3D models of the liver
~ Segment IAVa

-----

Segment VI Segment Il

N —
..
= A

e —

\ -

: ' e
'
)

gl

NG

N
.

| — . c’
- / v ’5-\
!

|

Segment VI ~ SegmentIl

Segment V ~ Segment [Vb o=
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]
|
i

.ﬁb 3D models of the liver

Segment |

Segment | ’I Segment VII

Segment | ‘
Segment IVb |y | *~ Segment VI

: -

| S—e;gment V
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oi¢? 3D models of the liver

Middle Left portal § E i

AEDENE Vel , W= |eft hepatic
Right portal F oy 50 00 o o *
vein R W ﬁl CaudaE/ein I R

Main portal

Right hepatic gat
vein -l
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ﬁ' 3D EXxploration of Liver Segments

Example:
What organ abuts the
left-most margin of
segment Il in this
patient ?
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3D Exploration of Liver Segments

3D

,,

@ # MByes: JM.QO DO ws9HE
ex [l

@BDSIicer

[» Help & Acknowledgement

®

I)

= Scene

= Liver Structures Models

= Vessels

= [VC [ |
= MainPortalVein
= LeftHepaticVein_and_Branches M
« MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
= CaudateVeins
gments
= LiverSegment_lI
= LiverSegment_|II
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
LiverSegmentVI
LiverSegmentVIl

EEEEEEEE

EEEETEE
EEEEEEEEE

| » Informg8lon

[~ Display
Visible:
Selected:
Clip:
Sliceg'

_ Select the module Models
. Click on the Liver Structures Models Hierarchy

= SRV an7e
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3D Exploration of Liver Segments

8006 3D Slicer 4.0.gamma-2011-11-24

& & Modules: . [@ Models " 00N @« A 9@ -E ‘E‘ 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement

> @ R R | 4~

I»)

= Scene
= Liver Structures Models
= Vessels
= [VC | |
= MainPortalVein
» LeftHepaticVein_and_Branches W
» MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches

Sobobodoatot
88888888

= LiverSegment_IVa
= LiverSegment_IVb
= LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
= LiverSegmentVI
= LiverSegmentVIl

EEEETEE [
Skttt
8888888

» Information

~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Select the model Liver_Segment |l
Turn on/off its visibility to locate
— it in the 3D viewer. —
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3D Exploration of Liver Segments

®

800 3D Slicer 4.0.gamma-2011-11-24
2 & [Modules: - |@ Models QOO0 IO & A @Ed o 4~
o= i
BY sosiicer

g

» Help & Acknowledgement

Position the mouse in
the 3D Viewer, hold
down the left mouse
button and drag to
orient the 3D model to
a superior view.

L
F
B
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gamma-2011-11-24

@ & |Modules: . [@Models QOO0 IO & A @Ed &t~ » Ao Ra v

Q 3DSlicer

» Help & Acknowledgement

= Scene
= Liver Structures Models
= Vessels

IVC | 10

MainPortalVein 1.0

LeftHepaticVein_and_Branches 1.0

MiddleHepaticVein_and_Bran... [ 1.0

RightHepaticVein_and_Branc... } 8
1.0
1.0

9

4999

» LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
» CaudateVeins

g

SOO00000o

= LiverSegment_IIl
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
= LiverSegmentVI
= LiverSegmentVII

EEENEN
[elelololotatal
[SIStStSISIStsts!

» Information |

~ Display |
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: &
~ Data Probe

What organ abuts the left-
most margin of segment Il

@wmr
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3D Exploration of Liver Segments

e 0o

3D Slicer 4.0.gamma-2011-11-24
& [Modules: © Models = ()~ QIO @« A @@ » o 4~

Question 1:

What organ abuts the left-

most margin of segment Il
in this patient?

Answer 1: Stomach

lice Lnter_sections V_isnble:
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3D Exploration of Liver Segments

XX 3D Slicer 4.0.gamma-2011-11-24
@ & |Modules: . [@ Models " QO IO e 42 @HE » PRI Y » fa fa, -
1
eO®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the

right adrenal gland ?

w i
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3D Exploratlon of leer Segments

e 0o gamm:

@ & |Modules: . [@Models :—Q\){DO@K\WQ I,O't
@®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the
right adrenal gland ? —
Answer 2: Segment VI

00000000
[slelstetetotots]

-e

EEETEE
0000000 Y
[SIStSIStstSISts|

W
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‘ﬁ' 3D Exploration of Liver Segments

~ Question 3:

" B \Which vessel separates
Segment Vb and
Segment V?

e
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Middle Hepatic Vein

000 3D Slicer 4.0.gamma-2011-11-24 u
& Modules: . [@Models =0 QI ® @« 4 @& F\t' | Mlddle
o= [l
@ 3DSlicer
v

| » Help & Acknowledgement |8
= Scene
= Liver Structures Models

= Vessels
o IVC m 1.00
< MainPortalVein 1.00
< LeftHepaticVein_and_Branches M 1.00
= MiddleHepaticVein_and_Bran... [§ 1.00
< RightHepaticVein_and_Branc... 1.00
< LeftPortalVein_and_Branches 1.00
< RightPortalVein_and_Branches 1.00
< CaudateVeins 1.00

= Segments
< LiverSegment_II

-
Q9
S

< LiverSegment_llI

< LiverSegment_IVa

LiverSegment_IVb

LiverSegment_|

LiverSeg mentVVI 1l
I

-
LiverSegmentVI|
< LiverSegmentVII

|» Information |

| ~ Display \

\liniklA.

Question 3:
Which vessel separates Segment IVb and Segment V?
Answer 3: The middle hepatic vein

o



Closing the Liver Scene

8eno 3D Slicer 4.0.gamma-2011-11-24

% # |Modules: (@ Models ]-eo DO e@sr@Z - Eet- > @ o R |4

!" 3pSlicer
4

| » Help & Acknowledgement

= Scene
= Liver Structures Models
ERVZ-INVNIN

~ Higniroraivein_ana_usrancnes
< CaudateVeins
= Segments
< LiverSegment_II
< LiverSegment_llI
< LiverSegment_IVa
= LiverSegment IVb
< LiverSegment_|

LiverSegment_ VIII

Liver! egmentVI
LiverSegmentVII

|» Information

| ~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: [ (]
| ~ Data Probe

wmr
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Part 4:

Interactive 3D Visualization
of the segments of the lungs
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N Segments of the lung

| | Segmentation and 3D surface
| | reconstruction of the lung and
| pulmonary vessels

Acknowledgment:

Segmentation of the lung surface and vasculature:
Raul San Jose Estepar, Ph.D., George Washko,
M.D., Ed Silverman, M.D. and James Ross, MSc.
Brigham and Women’s Hospital, Boston, MA
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N Segments of the lung

3D parcellation of arteries and veins from

original model of pulmonary vessels
(Kitt Shaffer, M.D., Ph.D. - Sonia Pujol, Ph.D.)

- Right Upper Lobe (RUL)
- RUL Pulmonary Vein
- RUL Anterior Segment
- RUL Apical Segment
- RUL Posterior Segment
- Right Middle Lobe (RML)
- RML Pulmonary Vein 1 & 2
- RML Lateral Segment
-  RML Medial Segment
- nght Lower Lobe (RLL)
RLL Pulmonary Vein 1,2,3
- RLL Anterior Basal Segment
- RLL Medial Basal Segment
- RLL Lateral Basal Segment
©2011 Surgical Planning Laboratory, ARR -  RLL Posterior Basal Segment




Loading the Lung Scene

™ QO INO® @ A 9§ & t viPersistent | @ Ra o, -
o= HI

7
N\ /
N /

Select File » Load Scene from the main menu

eeeeeeeeeeeeeeeeeeeee

Load the file LungSegment_Scene.mrml |located in:

C:\Documents and Settings\Administrator\Desktop\3D\LungData
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Loading the Lung Scene

0o
& & |Modules: . Welcome to Slicer OO0 D Ogs 4
e CIH

P : .
@ 3DSlicer R L E‘;la‘;
A [e[wa ]
Welcome
Load DICOM Data [eucy Load Data

@ Load Volume Data || @ Download Sample Data

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Kevboard

Position the mouse cursor in the
top left cornet of the 3D viewer,
and select the top left icon to
center the 3D view on the scene

[ss Ryl
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Loading the Lung Scene

800

3D Slicer 4.0.gamma-2011-11-24
2 & [Modules: - |Welcome to Slicer S

d= 00N e s @2 ~EHlelt-
\ansncer
v

e HA
Welcome

( Load DICOM Data || Load Data J
[ Load Volume Data || @ Download

ple Data |

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

Select the module Models from
the modules Menu.

~ Data Probe

W
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ung Segments

& Slicer File Edit View Help GO M D 4) @& 548PM Q
800 3D Slicer 4.0.gamma-2011-11-24
& [Modules: . [@Models =00 IO e« A9 HE » @l 4~ > @ A fa | v

e [l

@ 3DSlicer

[» Help & Acknowledgement =

= Scene
» chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
= RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1
= RightLowerlLobe_PosteriorBasalSegment
= RightLowerLobeMedialBasalSegmen
= RightLowerLobeAnteriorBasalSegment
= RightLowerLobe_LateralBasalSegment
= RightLowerLobe_PulmonaryVein4

Slicer displays the list of 15
surface models of pulmonary
structures.

[» Information 2 R - ~1

ENNEEEEEEEETE e
P e e e e
§8888888888888888%

[~ Display M

Visible:

Selected:

Clip:

Slice Intersections Visible:
v

Color:
Opacity: [
| ~ Data Probe

wmnr
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Lung Segments — Question 1

@ Slicer File Edit View Help GO MM = ) & 423PM Q
800 BRiSlicendi0icammas2 D114
@ & [Modules: . (@ Models DR 5) {D O @ A @ [ER @ t~

@®

@ 3DSlicer

[» Help & Acknowledgement

= Scene
< chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
- HightLowerLobe,SuFeriorSe ment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1

thtLowerLobe Posterlor asalSegment

EEEEEEEENNEEEE
8F3883358833585%

[» Information

[~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: ( []

]
Opacity: 711.00 |

Amhiant: ) nnn i«
|~ Data Probe

T
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Lung Segments — Question 2

@ Slicer File Edit View Help GO M = 4) G 425PM Q
800 3D Slicer 4.0.gamma-2011-11-24

%2 & Modules: - | @ Models
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Lung Segments — Question 2
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Lung Segments — Question 3
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Lung Segments — Question 3
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ung Segments — Question 4
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Lung Segments — Question 4
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3D Visualization of DICOM images

 Interactive user-interface to
load and manipulate
greyscale volumes,
labelmaps and 3D models.

» User-defined 3D view of the
anatomy

« 3D Open-source platform for
Linux, Mac and Windows
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www.slicer.org
WWW.Na-mic.org

Questions and comments: spujol@bwh.harvard.edu
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